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The Complete Resource for InDesign ProfessionalsFrom the Editor

Welcome to the first issue of indesign magazine.
The people contributing to this magazine—co-founder David Blatner and myself includ-
ed—have been through the desktop-publishing wars and bear the bruises and scars to 

prove it. We’ve spent 19 years trying them all: PageMaker, QuarkXPress, MacPublisher, Ven-
tura, Ready! Set! Go!, Ragtime, and a bunch of other upstart pretenders.

But Adobe InDesign is different. For the first time in a decade there is palpable excitement in 
the publishing industry. It’s as if we finally have the publishing application we’ve always wanted, 

one that not only unleashes our design creativity but 
also forms a stable foundation for production. Some 
of the credit must be given to InDesign’s tight integra-
tion with its sibling software Photoshop, Illustrator, 
GoLive, and Acrobat. Together these applications 
make it possible to produce pages with rich images, 
refined typography, and sophisticated effects then 
print them as rock-solid PDF files or publish them on 
the Web.

InDesign Magazine was produced with InDesign, 
of course, and we put its innovations to the test. 
Designed front to back by Scott Citron, InDesign 
Magazine can be printed out on your desktop printer 
or read on-screen with equal ease. We took advan-
tage of the interactive features of both InDesign and 
Acrobat. Click an entry in the table of contents and go 
straight to that story. Embedded hyperlinks for all the 
Web sites, e-mail addresses, and ads you see on these 
pages let you access additional information with one 
click. Look for these hyperlinks in red or just click on 
an ad. Scott also designed the navigation buttons you 
see at the bottom of each page.These buttons allow 
you to move quickly between pages as well as jump to 
the top of the story you’re reading. 

Let us know what you think. And if you like what you 
see, don’t forget to subscribe at www.indesignmag.com.

—Pamela Pffifner
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No one enjoys drawing clipping paths (or, if they do, they rarely 
admit it in public). InDesign’s transparency features spare you the 
headaches of drawing clipping paths because the program honors 
background transparency in Photoshop files. However, there are 
still times when a clipping path comes in handy, so don’t throw 

the Bézier out with the bathwater.
What most people don’t realize about clipping paths in InDesign is that you can 

convert them to editable InDesign frames. This turns out to be extremely useful 
when you need an InDesign object the same shape as your image—for example, 
when you need to print a varnish over a silhouetted image, or emboss just the 

image. Here’s how to do it.

1. DUPLICATE YOUR IMAGE
After importing your image and selecting it on the page, cre-
ate a new layer (Option/Alt-click on the New Layer button in 
the Layers palette to name the layer while creating it). Now, 

select your image and duplicate it onto this new layer in exactly 

NEW USES 

FOR OLD
CLIPPING PATHS

David Blatner shows how to turn a clipping path 
into an editable frame that can be used as a 
varnish plate. 

STEP 1
Dragging the 
Proxy Icon while 
holding down 
the Option/Alt 
key duplicates 
the object on the 
new layer.



InStep: Building a Varnish Plate

STEP 2
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the same place. To do this, you could copy it and then use Paste 
in Place. However, I prefer a faster method: Just hold down 
Option/Alt while dragging the little proxy square to the new 
layer.

2. TURN ON THE CLIPPING PATH
While the duplicate object is still selected, choose Object > 
Clipping Path. If you have already drawn one or more paths in 
Photoshop and saved them with the image, you can choose 
Photoshop Path from the Type popup menu in the Clipping 
Path dialog box.

If, however, you’ve sworn off drawing clipping paths—but 
the image is on a pretty clean white background—you can set the Type popup menu to 
Detect Edges. This is trickier, because you have to adjust the Threshold and Tolerance set-
tings until you “knock out” the background without erasing too much of the image itself. 
I almost never use Detect Edges to build a real clipping path (it’s just too blunt an instru-
ment), but it works well for this technique because a varnish or emboss plate rarely needs 
to be precise.

Either way, turn on the Preview checkbox in the Clipping 
Path dialog box to make sure the clipping path looks right 
on screen before pressing OK.

3. CONVERT THE PATH TO A FRAME
Now that you have your clipping path, you can swap it for 
a real InDesign frame. Right-click (or Control-click on 
the Mac) on the image and choose Convert Clipping Path to 
Frame from the context menu. The image shouldn’t appear 
any different, but if you switch to the Direct Select tool 
you’ll see the points and segments of an editable InDesign 

frame that looks suspiciously like 
your old clipping path.

4. DELETE THE IMAGE
While you’ve got the Direct Select 
tool, click on the image (not the edge of the frame) to select it. 
Now delete it. What remains is a frame that looks like a silhouette 
of the graphic. Here, I’ve hidden the lower layers to make it more 
obvious what’s on the varnish layer.

STEP 3

Step 4

STEP 4
Deleting the image from within 
the frame leaves the shape 
of the object (based on the 
clipping path’s shape).
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5. FILL WITH A SPOT
The only way to print a separate piece 
of film for the varnish or embossing 
plate is to fill your new frame with a 
spot color. If you don’t already have 
a spot color, take this opportunity to 
make one. I usually call it something 
clever like “Varnish Plate” and spec it 
at 15-percent yellow. (But remember 
to choose Spot from the Color Type 

popup menu in the 
Edit Color dialog 
box; you don’t want 
this to be a process 
color!)

6. MAKE IT OVERPRINT
The problem is that this colored object now knocks out the image 
beneath it. You can get around that easily enough: Turn on Overprint Fill 
in the Attributes palette and then select View > Overprint Preview. Note 
that the spot color makes the underlying image appear slightly yellowed 
(of course, this is just a screen representation of the effect).

7. PRINT SEPARATIONS
Because the tip relies on overprinting a color, if you print a proof to a non-PostScript inkjet 
printer you’ll need to turn on Simulate Overprint in the Print dialog box. However, when 
you print final separations, turn that feature off and you’ll get an extra plate—the spot var-
nish plate in just the shape you wanted. #

DAVID BLATNER is co-author of Real World InDesign CS (Peachpit Press). 

STEP 5

STEP 7
The varnish shape 
was defined by a spot 
color so it prints on 
its own plate

STEP 6
Turning on Overprint Fill in the 
Attributes palette tells InDesign 
not to knock out the image 
underneath the varnish plate.

Cyan

Yellow
Magenta

Black
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ike a child who sees a big plate of cookies but is  
told he can’t have any, a designer sees the tantalizing 

transparency features in InDesign CS and is often told not to use them. While completely 
avoiding transparency may sound like good advice, the reality is that you’ll be missing out 
on key functionality—such as the ability to place native Photoshop (.psd) and Illustrator 
files (.ai) into an InDesign layout. Additionally, there are many different ways transparency 
can be introduced into an InDesign file (which we’ll cover later in this article), meaning 
a designer can create transparency in a file without necessarily knowing it. Rather than 
ignoring it, learning a few key concepts about transparency will give you the confidence 
you need to use it.

The truth is, designing with transparency is similar in concept to driving a car. There are 
certain things you need to know, like the accelerator makes the car go faster, and the brake 
pedal makes the car stop. At the same time there are driving rules you have to follow, like 
speed limits and traffic signs. But there’s certainly no need to know how the engine under 
the hood actually works. Likewise with transparency, we’ll learn some basic rules and 
concepts that will help us understand what it is. More importantly, we’ll discuss the steps 
necessary to create and print InDesign files reliably, opening the door to the full power of 
InDesign.

Then again, if you’re a printer or a savvy production artist, knowing what goes on under-
neath the hood with transparency is more important than just about anything. Whether it’s 
InDesign CS or Illustrator CS, the concepts you’ll learn here will give you a solid under-
standing of the facts and help you build and output reliable files every time. 

Driver’s Ed
You may be wondering what all the confusion is to begin with. Why is transparency such a 
big deal anyway? Let’s start with a simple fact: PostScript doesn’t understand transparency. 

L by MORDY GOLDING

Transparency is one of the most important yet most 
misunderstood features of InDesign. Here’s what you 
need to know to make transparency work for you.

SEEING 
THECONFUSION

THROUGH

InDepth: Transparency
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As you probably know, PostScript is the language that printers and RIPs speak in (a RIP 
is a Raster Image Processor, used to create film or plates through an imagesetter). Native 
transparency is understood only by PDF 1.4 or higher (Acrobat 5, Illustrator 9).

Programs like InDesign CS and Illustrator CS, which allow you to design with transpar-
ency, use a process called “flattening” to convert transparency to a form that PostScript 
will understand. If you’ve used Photoshop before, you might think that flattening refers 
to collapsing all of the layers of a file into a single layer; however in the case of transpar-
ency flattening it means breaking art up into pieces so that a PostScript printer can print 
it. In a simple example where you have two overlapping transparent objects, the flattening 
process will break the art into three distinct pieces (called atomic regions)—the two objects 
themselves and the part that overlaps each other. The important thing to understand about 
flattening is that the final visual appearance of the art is unchanged (Figures 1 and 2). 

The reason why there are so many issues surrounding transparency is because some-
times the flattening process results in parts of your art becoming rasterized. With the 

wrong flattener settings, this can result in text that looks chunky or 
pixelated, noticeable shifts in color between raster and vector ele-
ments (called stitching), or white boxes—all unacceptable. However, 
with the correct settings, you can achieve perfect results every time.

Not every document needs flattening—only those with transpar-
ency in it. The tricky thing is that transparency can be introduced 
into an InDesign document in any of several different ways:

< Apply a blend mode or an opacity value other than 100%
 from the Transparency palette
< Apply the Object > Drop Shadow feature
< Apply the Object > Feather feature
< Place a native Illustrator file that contains transparency
< Place a native Photoshop file that contains transparency

The easiest way to tell if there’s transparency on your page is to 
look at the Pages palette. Any page that has a transparent object on 
it (requiring flattening) will have a checkerboard pattern on its page 
icon (Figure 3). This flattening process occurs whenever you print a 
file (or choose to export a file in the EPS format). The flattening itself 
happens on the way to the printer, so it never affects your original 
InDesign file itself.

High-Performance Driving School
Why does rasterization have to happen at all? And more importantly, 
who decides where and when rasterizaton will occur, and is it some-
thing that one can even control? The answers to these important 
questions—and tomorrow’s weather—tonight at 11:00. Seriously 

Figure 1: Artwork with transparency applied

Figure 2: That same artwork, flattened, with the atomic 
regions pulled apart so you can see the result of the 
flattening

InDepth: Transparency
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though, it’s important to realize that some files won’t require rasteriza-
tion at all. For those files that do require it, the flattening process has two 
levels of rasterization it can use. Let’s talk about these two levels in depth.

One level is where InDesign will rasterize a region because there is 
simply no other possible way to preserve the appearance in vector form. 
For example, you have a photo with a soft drop shadow that overlaps 
a background. The only way to preserve that appearance is to rasterize 
the background together with the drop shadow (which is a raster-based 
effect). By the way, this is why printers or applications that can’t support 
transparency end up displaying a white or black box in an area where a 
drop shadow should be—the appearance is changed. Think about it this 
way: before InDesign, you could create the described effect by composit-
ing the drop shadow with the background in Photoshop. The only differ-
ence now is that InDesign is doing the compositing for you, and at a later 

stage in the design process.
Another level of rasterization is where InDesign analyzes the entire file and looks for 

complex areas where there are many overlapping objects (which would result in a large 
number of atomic regions). InDesign then chooses to rasterize those specific areas for per-
formance reasons. These areas are referred to as “complex regions.” While we’re trained to 
know that vector objects are simpler than their bitmapped counterparts, try to imagine an 
Illustrator graphic filled with a pattern that overlaps several other objects and has transpar-
ency applied. While it may only seem like several objects at first glance, once those objects 
and the pattern are broken up into atomic regions, we may be looking at thousands of vec-
tor shapes. That’s enough to challenge even some of today’s advanced RIPs. In those cases, 
InDesign can save precious RIP and printer time by rasterizing these complex regions.

As far as the first level goes, we really have no choice but to allow InDesign to rasterize 
objects where it needs to. What we can do however is learn how to build files that work 
around this issue. For example, if I know text that appears beneath a drop shadow will 
become rasterized, I will be careful about where I place my text in my design (see later in 

Figure 3: Here you can see 
that pages 1, 4 and 5 have 
transparency in them, and will 
require flattening.

Figure 4: Text that is 
underneath the drop shadow 
will get rasterized, as indicated 
by the Flattener Preview with the 
All Rasterized Regions checked 
(items in red will become 
rasterized during the flattening 
process).
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this article about placing text on it’s own top-lev-
el layer). With regards to the second level of ras-
terization, we can control how liberal InDesign 
is when looking for complex regions. In fact, we 
can even disable this second level of rasterization 
altogether. Finally, with either level of rasteriza-
tion, InDesign always gives us total control as to 
how these areas are rasterized.

Tweaking the Engine
Before we actually discuss the different flattener 
settings, it would be helpful to know if the docu-
ment you’re working on is even going to require 
any of the two levels of rasterization we spoke 
of earlier. InDesign CS has something called the 
Flattener Preview palette, which you can find by 

choosing Window > Output Preview > Flattener. By choosing an option from the Highlight 
popup list in the palette, InDesign will highlight specific areas in your file in red, indicating 
where rasterization will occur. 

For example, by choosing Transparent Objects from the Highlight list, InDesign will 
show you the location of all objects on your page that use transparency—although those 
regions may not necessarily become rasterized. To see which parts of your file will be 
rasterized, choose All Rasterized Regions (Figure 4). We had also mentioned above that 

InDesign looks for complex areas of a document, and you can see where those areas 
are by choosing Rasterized Complex Regions in the popup. Additionally, the All 
Affected Objects option shows us all the objects that may not be transparent them-
selves, but interact with transparency in some way (like the example we mentioned 
above with the drop shadow over a background: the background itself doesn’t have 
transparency applied to it, but in order to preserve the appearance of the drop 
shadow, the background will have to be merged with the shadow, hence affecting the 
background).

This preview palette is more than just a nice way of letting us know what InDesign 
is doing. It’s also a tool we can use to help us make adjustments to our files or our 
flattener settings to get better results—all before we spend time and money by print-
ing film or plates. For example, if we see that certain text is affected by a nearby or 
overlapping transparent object, we can make an adjustment in our file to avoid that 
(Figure 5). Additionally, if we see that InDesign is being very liberal about rasterizing 
complex regions, we can make adjustments to the flattener settings and force InDe-
sign to preserve those areas in vector form.

The Flattener Preview uses one of three “presets” out of the box to flatten files—
High Resolution, Medium Resolution, and Low Resolution—and you can choose one 
of these in the Preset popup in the palette as well (Figure 6). In this way, you can see the 
different results in how InDesign flattens a file with these different settings. By choosing 
Transparency Flattener Presets from the Flattener Preview palette menu, you can get at the 
actual flattener settings themselves. Click on the New button and you can even define your 
own custom presets (which you can share with your friends and clients).

Figure 5: The same text, moved 
to its own higher-level layer, will 
not become rasterized. Notice 
the Flattener Preview indicates 
that the text itself is not red.

Figure 6: The three flattener 
settings for the Low, Medium, 
and High Resolution presets. 
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Let’s explore the settings in the Transparency Flattener Preset Options dialog box.

< Raster/Vector Balance: This slider is what actually controls how liberal 
InDesign is when looking for complex regions to rasterize (what we’ve defined 
above as the second level of rasterization). A number closer to 0 will give 
InDesign more freedom to rasterize at will, resulting in faster print times. 
Moving the slider closer to 100 will result in fewer rasterized areas, but longer 
print times. At the 100 setting itself, InDesign will not rasterize any parts 
of the file for performance reasons, effectively disabling the second level of 
rasterization altogether. The High Resolution flattener preset uses this setting. 
In cases where files are taking extremely long to print (or crashing the RIP 
altogether), adjusting this slider to a slightly lower setting will help.

< Line Art and Text Resolution: In cases where InDesign is going to rasterize line 
art or text, you can specify a resolution that will result in good-looking, sharp 
output. You’ll notice that the High Resolution flattener setting specifies a 
resolution of 1200 ppi, ensuring that text elements and vector objects will still 
have nice clean sharp edges in final output.

< Gradient and Mesh Resolution: Because gradients and meshes are continuous 
tone in nature, they don’t require a resolution as high as line art or text. In 
fact, anything twice your line screen is probably getting thrown out anyway. 
Therefore, InDesign uses this setting to rasterize elements that can afford to be 
set at a lower resolution. You’ll notice that the High Resolution flattener preset 
uses a value of 300 ppi.

< Convert All Text to Outlines: In cases where text is going to be rasterized, 
chances are that the rasterized text will look a bit chunkier than regular vector 
text. To compensate for this, you can turn on this option to convert all text to 
outlines, giving a consistent, chunkier look to all of your text. If you use the 
method I describe below to move text onto its own layer, you’ll rarely need to 
concern yourself with this setting.

< Convert All Strokes to Outlines: Similar to the previous setting, this will 
compensate for disparity between vector and rasterized strokes by converting 
all strokes to outlines.

< Clip Complex Regions: We mentioned that InDesign can look for complex areas 
of a file and choose to rasterize them for performance reasons. However, we 
know that raster images are always rectangular in shape, which means it’s 
possible for “innocent” parts of your file to become rasterized simply because 
they fall into the rectangular bounding box of the area that is complex. More 
often than not, this results in stitching, or noticeable boxes and color shifts. 
The Clip Complex Regions option avoids this issue by creating a clipping mask 
around any rasterized complex region (so the rectangular-shaped raster is 
masked by the vector outline of the object). As you can probably understand, 
this makes for even more complex files and could result in longer print times 
as well. This option is turned on in the Medium Resolution flattener preset, but 
isn’t applicable at all in the High Resolution preset because no complex regions 
are rasterized at all with that setting (as it has a Raster/Vector Balance setting 
of 100).

SHIFT INTO HIGH GEAR

Follow these simple steps 
in InDesign and you’ll be on 
your way to creating high-
performance files that print 
reliably every time.

1. Bring text on to it’s own 
top-level layer

2. Use the High Resolution 
flattener preset setting

3. Place native Illustrator 
and Photoshop files into 
InDesign layouts

4. Talk to your printer

5. If you’re unsure where 
your file might end up, 
send a PDF/X-1a file

10 InDesign Magazine * JULY | AUGUST 2004  



To take advantage of all that the Flattener Preview can offer, adjust the different flattener 
settings and preview the results—making changes or adjustments where necessary—all 
before you actually print the file. As an aside, Illustrator CS also contains a similar Flattener 
Preview palette and identical flattener settings (in fact, it’s the same underlying code).

What Are You Driving?
To throw yet another variable into the mix, the kind of printer or RIP that you use can also 
render different results. For the most part, any Adobe PostScript Language Level 3 device 
should be able to handle transparency without issue. Specifically, PostScript version 3015 
(which appears in the latest versions of RIPs) has enhanced functionality to process files 
with transparency in them.

There are some older print devices that are confused by the effects of flattening. For 
example, Scitex (since acquired by Creo) RIPs look at jobs that are printing and split up 
the vector and raster elements onto two layers. The rasterized content prints on a CT layer 
(Continuous Tone) at a lower resolution (like 300 dpi) and line art prints on a separate vec-
tor layer at a much higher resolution (like 2400 dpi). Since flattening could cause a vector 
object to be rasterized, the RIP only sees that raster as a CT image and prints it at the lower 
resolution. This might cause text that is rasterized to print with noticeably jagged edges. 
Scitex has since updated its RIPs to address this issue, but that doesn’t automatically mean 
that everyone who owns a Scitex RIP has installed the update (or knows that it exists).

Bottom line, the best advice in any case is to talk with your printer. For any big job, most 
printers will be happy to run a test file for you, to make sure everything will print correctly. 
Taking advantage of these opportunities will surely save headaches when press deadlines 
loom. Adobe also has free specialized training materials for print service providers if your 
printer needs more information (found online at http://partners.adobe.com/asn/programs/
printserviceprovider/index.jsp)

Car Pool Anyone?
Rarely is InDesign used alone, and design layouts pick up numerous Illustrator and Photo-
shop files along the way. In the past, you may have used EPS or TIF files, but with InDesign, 
you can take advantage of the common technology between all of these “sweet” applica-
tions (sorry, couldn’t resist). It’s best to place native .ai files from Illustrator (native Illustra-
tor files are really PDF 1.4 files) and native .psd files from Photoshop into your InDesign 
layouts. Besides all of the benefits you get from using native file formats, like using layered 
Photoshop files, InDesign is also handling all of the necessary flattening at the latest pos-
sible point in your design workflow.

Defensive Driving
One can avoid accidents by learning to anticipate possible problems and learning about 
driving techniques. The same is true of transparency, so think of this as a defensive driving 
course for creating files that print.

Pay attention to the flattener presets—Low Resolution, Medium Resolution, and High 
Resolution. For quick proofs to your laser printer, you can use the Low or Medium setting, 
but when printing to a high-end proofer or imagesetter, use the High setting (Figure 7). 
You’ll find the Transparency Flattener setting in the Advanced panel of the Print dialog. By 
the way, these same settings are found in Illustrator CS’s print dialog as well.
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With new support for InDesign Books and CS, 
Imposer Pro is a plug-in for Adobe InDesign that
imposes document pages into printer flats. Imposer
Pro offers six sheet types (2-Up, 4-Up, 8-Up, 2-Up
Consecutive, 3-Up Consecutive, and 4-Up Consecutive),
four binding types (Saddle Stitch, Perfect Bound,
Stacked, and None) and five imposition types
(Standard, Work and Turn, Work and Tumble, Split
Web, and Sheet Wise). To meet all your imposition
needs — such as using different imposition methods
for the same document — you can choose which
pages to impose and how many signatures to create.

Imposer Pro can save imposed documents as separate
InDesign files or handle all the imposition in the print
stream, leaving the document itself untouched. Either
way, you don’t need to add, shuffle, or rotate pages
— Imposer Pro will handle everything for you.

InBooklet adds printer spread functionality
to Adobe InDesign. InBooklet will impose
pages both as saddle stitched and perfect
bound publications and provides control
over margins, gaps, bleed, creep, and
crossover trapping.

New to version 3.0 is the ability to impose
multiple documents from an Adobe InDesign
book, thus eliminating the single document
imposition limit. Also new is the ability to
save settings as an InBooklet style thus pro-
viding consistency and ease of use across 
documents. Additionally version 3.0 supports
Adobe InDesign CS.

Whether your production piece is a brochure
or a book, InBooklet offers a seamless, easy-
to-use solution to Adobe InDesign.

Create Imposed Printer Flats
in Adobe® InDesign.®

InBooklet 3.0Printer Spread functionality
for Adobe® InDesign.®

Available for 
Macintosh and Windows!

Available for 
Macintosh and
Windows!

© Copyright 1990-2004. a lowly apprentice production, inc. All rights reserved.

For more information about these products, or to download a free demo,
visit the a lowly apprentice production website at: www.alap.com

You can also call us toll free at: 1-888-818-5790
or 760-438-5790 (Canada/International) www.alap.com

To avoid text becoming rasterized, create a new 
layer in your InDesign file, and place all of your text 
on that layer (Figure 8). As long as you keep that text 
layer as the top layer in your document, you won’t 
have to worry about chunky or pixelated text.

A potential problem is that even if you  as a design-
er are aware of transparency, there are still plenty of 
printers out there who aren’t. If you are sending out 
a file, and aren’t sure who will be printing it or what 
they will be using to print it, I’ve found that the most 
reliable way to send the file is as a PDF/X-1a file. PDF/
X is a standard that was defined for validating a PDF 
file with minimum print requirements (for example, a 
validated PDF/X-1a file has no RGB or transparency 
info in it, and all fonts must be embedded in the docu-
ment, etc.). You can export a PDF/X-1a file directly 
from InDesign CS by choosing File > PDF Export 
Presets > [PDF/X-1a] (Figure 9).

Step on the Gas
Finally, just like you join an organization like AAA to help you when your car 
has trouble, it’s always best to keep in touch with others in the design community 
who can help. Subscribe to magazines (such as this one), join your local InDesign 
User Group (www.indesignusergroup.com), and participate in an online forum, 
such as www.printplanet.com or Adobe’s User to User forums. 

Designing with transparency will allow you to create things that were previ-
ously prohibitive and difficult 

to implement, allowing you to save valu-
able time while being even more cre-
ative. Now that you know how transpar-
ency works and what’s necessary to use 
it in your workflow, give it a test drive. 
You’ll be happy you did. #

MORDY GOLDING is an author, trainer, and 
consultant in New York and has recently started 
www.designresponsibly.com, a site dedicated 
to helping designers create print-ready files. His 
latest works are SAMS Teach Yourself Adobe 
Creative Suite All in One and The Complete Guide 
to Adobe Illustrator CS (DVD). 

Figure 7: Choosing the High Resolution Flattener Preset in the Print dialog.

Figure 8: Adding a layer for text 
objects at the top level of the 
document.

Figure 9: Choosing to export a PDF using the 
PDF/X-1a standard.
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Imposer Pro 1.1.1Imposer Pro 1.1.1

With new support for InDesign Books and CS, 
Imposer Pro is a plug-in for Adobe InDesign that
imposes document pages into printer flats. Imposer
Pro offers six sheet types (2-Up, 4-Up, 8-Up, 2-Up
Consecutive, 3-Up Consecutive, and 4-Up Consecutive),
four binding types (Saddle Stitch, Perfect Bound,
Stacked, and None) and five imposition types
(Standard, Work and Turn, Work and Tumble, Split
Web, and Sheet Wise). To meet all your imposition
needs — such as using different imposition methods
for the same document — you can choose which
pages to impose and how many signatures to create.

Imposer Pro can save imposed documents as separate
InDesign files or handle all the imposition in the print
stream, leaving the document itself untouched. Either
way, you don’t need to add, shuffle, or rotate pages
— Imposer Pro will handle everything for you.

InBooklet adds printer spread functionality
to Adobe InDesign. InBooklet will impose
pages both as saddle stitched and perfect
bound publications and provides control
over margins, gaps, bleed, creep, and
crossover trapping.

New to version 3.0 is the ability to impose
multiple documents from an Adobe InDesign
book, thus eliminating the single document
imposition limit. Also new is the ability to
save settings as an InBooklet style thus pro-
viding consistency and ease of use across 
documents. Additionally version 3.0 supports
Adobe InDesign CS.

Whether your production piece is a brochure
or a book, InBooklet offers a seamless, easy-
to-use solution to Adobe InDesign.

Create Imposed Printer Flats
in Adobe® InDesign.®

InBooklet 3.0Printer Spread functionality
for Adobe® InDesign.®

Available for 
Macintosh and Windows!

Available for 
Macintosh and
Windows!

© Copyright 1990-2004. a lowly apprentice production, inc. All rights reserved.

For more information about these products, or to download a free demo,
visit the a lowly apprentice production website at: www.alap.com

You can also call us toll free at: 1-888-818-5790
or 760-438-5790 (Canada/International) www.alap.com

http://www.alap.com


InQuestion: Sandee Cohen

InQuestion is a regular column devoted to answering 
subscribers’ questions about working with InDesign. 

Scaling Strokes, Flowing Text, 
Unlocking Items, and the Case of 
the Missing Pasteboard
By SANDEE COHEN

Scaling Strokes?
Q: Why on earth can’t I scale a 
ruled box and have its line-weight 
scale proportionately? In Illustrator, 
this is a breeze, but InDesign doesn’t 
seem to scale the stroke. Strangely, the 
only way I’ve found to scale a stroke 
is when it’s applied to text. Surely 
there must be a way to scale strokes 
applied to objects. 

—Thomas Bricker, New York City

A: You’ve stumbled on an 
InDesign “feature” that makes me 
crazy. It all has to do with the Scale 
Strokes command in the Transform 
or Control palette menu.

When Scale Strokes is turned on, 
then the line width changes when 
you scale the object using the Scale 
tool, the Transform palette, or the 
Control palette (not when you just 
drag the corner or side handles). 
What’s confusing you is that the 
@#$%^&! stroke width doesn’t 
change in the Stroke or Control pal-
ette! What’s worse, if you scale the 
object disproportionally, the stroke 
is thinner in some places and thicker 
in others. Obviously this is insane. 
(Figure 1).

Now, you may ask why would 
the InDesign engineers allow this 
situation to exist. My answer is that 
I have found it better not to ask 
why about any of the decisions that 
engineers make. The answers always 
make my head hurt.

Okay, now here’s the solution: 
With the object still selected, choose 
Reset Scaling to 100% from the 
Transform or Control palette menu. 
The stroke weight will now show 
the correct size  and the thickness 
will be consistent around the whole 
object. 

Where’s My Pasteboard?
Q: Help! Suddenly the entire 
pasteboard area of my document has 
disappeared and has been replaced 
with a gray background. And all my 
columns, and guides, and invisibles 
are gone, too. I tried closing and 
reopening the document, but that 
hasn’t worked. Is my document cor-
rupted?

—Panicked in Peoria

A: Relax, there’s nothing wrong 
with your document. Make sure you 
don’t have an insertion point in a 

Figure 1: Surely the scaled-
down frame looks thinner, but 
according to the readout in the 
Stroke palette, its weight is still 
4 points.
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Figure 3: To autoflow text onto 
multiple master pages, keep 
Master text Frame unchecked 
when creating the document.
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Place command to load the text cur-
sor. Place the cursor in the top-left 
corner of the margin and hold the 
Shift key as you click. The text will 
flow automatically through all the 
pages. Of course, this only works if 
you want the text frame to extend all 
the way out to the margins.

Unlocking Master Page Items
Q: How the heck am I supposed 
to place pictures in my master page 
picture boxes when I can’t select 
them? There seems to be some sort 
of lock on the items from the master. 
How do I unlock them?

—Confused in Connecticut

A: Hold Cmd/Ctrl-Shift and 
then click on the object you want 
to release. Master page items are 
protected from being inadvertently 
moved. You can also choose Over-
ride All Master Page Items from the 
Pages palette menu to release all the 
master page items on a spread. #

SANDEE COHEN is the only third-party author 
to have written educational materials for all 
four versions of InDesign. Her latest book 
is the InDesign CS Visual QuickStart Guide 

(Peachpit Press). 

Have a question for Sandee?  
Send your questions to 
sandee@indesignmag.com.  
Please indicate if you don’t want 
your name used. We reserve the 
right to edit questions for space 
and clarity. Not all questions can 
be answered, nor will they be 

—Cindy, Production Supervisor

A: You’re not the first one to 
complain about this. 
What happens is that In-
Design adds pages based 
on the first page that the 
text flowed onto. 

I had just about given 
up on being able to fix 
this, when your request 
appeared on my desk. 
And I decided to try one 
more solution. Amaz-
ingly, I found it!

The solution is to stop 
using master text frames 
on your master pages. As 
a former Brand X user, I 
have always insisted on 
applying a master text 
frame. But I’ve just dis-
covered that if you don’t 
use a master text frame, 
InDesign will flow the 
text properly through all 

the pages. 
Create your InDesign template 

and master pages as usual, but don’t 
check Master Text Frame (Figure 3). 
Then, on the document page, use the 

text frame, and then press the W key. 
Your pasteboard and non-printing 
elements will reappear.

What has happened 
is that somewhere you 
clicked the W key, which 
is the shortcut for the 
Preview mode. You can 
also get out of the Preview 
mode by clicking the Nor-
mal View mode icon at 
the bottom of the toolbox 
(Figure 2). 

By the way, the Preview 
mode is a great way to 
present your work to cli-
ents and/or bosses. It also 
hides any non-printing 
objects.

Flowing Text onto 
Specific Masters
Q: Our organization 
has a problem. We have a 
catalog template that uses 
two master pages (A and 
B) and applies them to every other 
spread—1A-2A-3B-4B-5A-6A-7B-8B, 
and so on. Unfortunately, when we 
autoflow the text onto the first page 
(1A), it flows onto pages 1, 2, 5, 6, 
and then onto page 9. It seems to skip 
all the pages set with the B-Master.

We’ve tried manually unlocking the 
master text frames and then linking 
them by hand, but that seems like an 
awful lot of work. And considering 
that Brand X would flow the text au-
tomatically, my staff is starting to feel 
that we’ve made a mistake moving to 
InDesign. Is there any way to get the 
text to flow automatically through all 
the master pages?

Figure 2: Clicking on the 
Normal View icon on the 
bottom left will restore a 
lost pasteboard.

mailto:sandee@indesignmag.com


InPerson: Will Eisley

DAVID BLATNER: Can you give a brief overview of 

your involvement with Adobe and InDesign?

WILL EISLEY: After getting an undergraduate 

degree in journalism, I went to RIT [Rochester 

Institute of Technology] for its program for graphic 

arts publishing. I came to Adobe from there, work-

ing in the Printing Group on a couple of projects, 

PressReady—which I’m sure you remember—and 

InProduction. Then, in about March of 2000—right 

around the time InDesign 1.5 was coming out—I 

moved to Adobe’s Seattle office and started work-

ing on InDesign. Maria Yap was the lead product 

manager on InDesign 2, and I worked closely with 

her. For the InDesign 2 release, I focused a lot 

on the print experience (like the Print dialog 

box), the PDF export area, the graphics area.

For InDesign CS, I became the lead 

product manager, so I helped to oversee all 

the areas the team focused on: print, graph-

ics, all the new CS features. My role now is 

Group Products Manager, so I manage the 

development teams for InDesign, InCopy, and 

GoLive. We recently moved GoLive under the lay-

out design team because Web layouts and 

print layouts are, to some 

degree, still based on 

a layout metaphor. 

So, while InDesign 

and GoLive have 

different uses, it 

makes a lot of 

sense to have 

them under one 

product manage-

ment team.

DB: While you 

were working 

on InDesign CS, what was the primary develop-

ment philosophy?

WE: We actually had a “zen” for the product: make 

this the most usable, best-performing, most in-

novative page-layout product on the planet. Sort of 

a grand goal, but really, the idea was productivity. 

How do you increase user productivity? And there 

are lots of little ways you can do it, so we spent 

a lot of time focusing on what I call “little things.” 

Like double-clicking on text with the Selection 

tool to switch to the Text tool, the Control palette, 

the common keyboard shortcut for the grabber 

hand [Option/Alt-spacebar], those types of things. 

Added up as a whole, these ended up represent-

ing huge time savings for many users from either 

their QuarkXPress workflow or from using earlier 

versions of InDesign.

In addition, we listened to customers and we 

heard that performance in InDesign 1.0 and 1.5 

was not acceptable. So we spent tons of effort to 

make InDesign 2 much faster than InDesign 1.5, 

and our goal was to make CS faster than 2. It’s 

sort of atypical for a product, because as most 

companies add features, their programs tend to 

slow down.

DB: Right. So increased usability and increased 

performance?

WE: We call it “productivity.” Productivity is perfor-

mance and usability—because usability is user 

performance, right? If it takes the user five steps 

to do something, that’s a performance problem 

on our side. We need to figure out how to make 

that into two steps. Increase the user’s productivity, 

which increases performance. They’re really two 

sides of the same coin.

Another goal was network publishing, so we fo-

cused a lot on XML— supporting things like support 

for DTDs within InDesign. I think many publishers 

WHILE INDESIGN CS IS A FINE PIECE OF SOFTWARE, what makes it special 
are the people who use it—the designers and production artists—and those who 
make it—the Adobe engineers, product managers, and support staff.  

InPerson is a regular feature 
in which we interview the 
people behind the product 
to see what makes them 
and InDesign tick. In this 
issue, David Blatner talks 
to Adobe’s Will Eisley, 
Group Product Manager 
for InDesign and related 
products. 
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are still trying to figure how they’re going integrate 

XML in their workflow. And rather than be rigid like 

some other tools, our notion is to be as flexible as 

possible and give the users the tools the way they 

want.

DB: Most people use InDesign for print applica-

tions. Is InDesign really the place to handle new 

media, too?

WE: Absolutely. We added the multimedia ability to 

play movie and sound files in InDesign CS. We’re 

finding that this is something advertisers are start-

ing to move towards. How do they take their print 

ads and make them interactive? I know a couple 

of designers who are working on interactive bro-

chures for auto manufacturers that include video 

of the car they’re trying to advertise.

DB: What are your favorite aspects of InDesign, 

parts that you may have worked on particularly 

hard, or that you had a lot of interest in?

WE: That’s so hard, because there are so many 

aspects of InDesign I find so refreshing—I mean, I 

was a QuarkXPress user for many years! I think the 

integration with the other Adobe applications is 

just such a key differentiator. That you can work so 

smoothly among these applications, place native 

Photoshop and Illustrator files in InDesign—that 

alone is a huge timesaver for many people. I think 

InDesign’s approach to XML and some of the 

new technologies is also really innovative, and 

what I think is so powerful is that we’ve been able 

to accomplish that without losing focus on our 

print customers; because we know that, for many 

customers, it starts with print today.

It’s also been exciting to see the transition 

in the industry. You know, a couple years ago 

people may have been struggling to find each 

other—“where are the other InDesign users?” But 

now, to see people become passionate about the 

product, and then see them become evangelists… 

It’s rewarding to see that network—the infrastruc-

ture around the product—continue to grow as the 

product matures: Seeing over 10,000 [Adobe 

Solution Network] service providers, with 92 per-

cent of them accepting InDesign files. Seeing the 

design schools [RIT, School of Visual Arts, Carnegie 

Mellon] switch over to InDesign. Seeing major cus-

tomers switch over: Macy’s West, Wal-mart, Fossil...

DB: Is it true that there are a number of develop-

ers on the InDesign team who used to develop for 

QuarkXPress?

WE: We really do have, in my mind, some of the 

best engineers in the industry working on this 

product right now. They’re former PageMaker devel-

opers, other Adobe engineers, former Quark engi-

neers—including some of the initial QuarkXPress 

development team. It’s exciting because Adobe’s 

customer focus along with deep innovation and a 

strong technical talent just makes for a great work 

environment to build a product.

DB: Is it your goal to kill QuarkXPress?

WE: I don’t think we approach it that way at all. 

We approach it from “How do we build the best-

of-class page layout software? How do we solve 

customers’ problems? How do we innovate in ways 

that haven’t been done before?” If the end result 

is that InDesign is the thought leader, or is taking 

market share from Quark, then that’s the end result. 

But we’re not motivated by a desire to kill Quark. 

We’re motivated by a desire to build the best 

page layout software product for our creative-pro 

customers.

DB: So where does the InDesign team go from 

here? What’s the “zen” that drives you forward?

WE: We could still be better. I mean, yes, we’re best 

of class, but there are still areas that we could help 

address better. I remember reading that someone 

in the industry said, “Innovation for page layout is 

dead.” And that came as such a foreign thought 

to us, because we looked and there are so many 

areas, it’s hard to prioritize the ones you want to 

hit first. Especially as we continue to move forward 

with the Creative Suite. That’s only going to con-

tinue to get stronger and stronger: you know, the 

relationship and integration among the applica-

tions in the Creative Suite. #

DAVID BLATNER is the Editorial Director of 
InDesign Magazine and the co-author of  
Real World InDesign CS.

Adobe’s Seattle campus photographed on a rare, sunny day.

 “IF IT TAKES THE USER FIVE STEPS TO DO SOMETHING, THAT’S A 
PERFORMANCE PROBLEM ON OUR SIDE. WE NEED TO FIGURE OUT 
HOW TO MAKE THAT INTO TWO STEPS.”
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Recipes for Applying—and 
Ignoring—Text Wrap

Whip Up a Few Tasty Treats Using InDesign’s Text Wrap Features

By DIANE BURNS

It doesn’t take long to 
discover the useful-
ness of InDesign’s 
Text Wrap feature. 

After all, text wrap is that lovely fea-
ture that, among other things, allows 
our text to have a, shall we say, muy 
compatible relationship to adjacent 
graphics or even other text. Text 
Wrap is simply applied by selecting a 
frame or object around which you want text to wrap, then setting the desired wrap using 
controls in the Text Wrap palette  by choosing Window > Text > Text Wrap. Applying a text 
wrap creates an editable text wrap boundary around an object. 

The icons across the top of the palette indicate the 
basic text wrap shape (Figure 1).  
Once the basic shape is selected, you can set the inset 
values, and in the case of Wrap Around Object Shape 

, known as contour wrapping, you can also set the 
text wrap boundary to be the same as the image’s clipping 
path or alpha channel. Unlike in QuarkXPress, text wrap 
in InDesign takes effect regardless of the layering order 
of objects. 

However, even though text wrap can be essential to 
achieving a certain effect, there are times when we need 
text wrap around one area of an object, but not another. 
For example, we might need body text to wrap around a graphic, but not a headline. That’s 

when a little check box, located far away from the 
Text Wrap palette, comes into play. This little text 
wrap helper, Ignore Text Wrap, can be found at the 
very bottom of the Text Frame Options dialog box 
under Object > Text Frame Options (Figure 2). To use 

this handy feature, select the frame containing the text that you don’t want to be affected by 
an overlying item that has Text Wrap applied, and check Ignore Text Wrap. With Text Wrap 
and Ignore Text Wrap, you really can have it both ways. Use Ignore Text Wrap when you 
want to create interesting pull quotes, headlines with graphics slightly overlapping them, or 
even to put a price on your products! #
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Figure 1: Text Wrap palette

Figure 2: Text Frame Options dialog (detail)

Inside InDesign: Text Wrap
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Wrapped Graphics Over Text

Ingredients
1 Headline
1 Graphic
Body text to taste
The Text Wrap palette
The Text Frame Options dialog box

DIRECTIONS: Take one headline and one two-column frame of body 
text; position on page. Place graphic. Apply text wrap to the graphic by clicking the  
icon in the Text Wrap palette. Position the graphic over the text frames. The headline text 
will momentarily be pushed out of its frame by the text wrap on the graphic; select the 
headline text frame, open the Object > Text Frame Options dialog box, and click Ignore Text 
Wrap. The headline will flow back into its frame, and the graphic can be positioned over it 
freely without displacing the text. 

Serve chilled with garnish. Perfect with margaritas on the rocks.

Text Wrap à la New York Times

Ingredients
1 Capital letterform in your favorite font (e.g., Berthold City)
The Create Outlines command (optional)
The Text Wrap palette
The Text Frame Options dialog box

DIRECTIONS: Type a capital letter in a text frame. Increase 
size as desired. Optionally, you can convert the charac-
ter to outlines to make easier to work with: Click on the 
frame with the Selection tool and covert to outlines using 
the Create Outlines command. Create a separate text 
frame containing the pull quote text, and apply text wrap 
to the pull quote text frame by clicking the  icon in 
the Text Wrap palette. Position the pull quote text within 
the main story, and set the desired insets for the wrap. 
Position the outlined capital within the pull quote and 
main story. Apply text wrap to this frame. The pull quote 
text will momentarily be pushed out of its frame by the 
text wrap on the capital; select the pull quote text frame, 
open the Object > Text Frame Options dialog box, and click Ignore Text Wrap. 

Serves thousands of readers every Sunday.

Ignore Text Wrap is applied to the frame containing the headline, 
which would otherwise be pushed out of its frame.

Text Wrap is applied to the 
graphic, causing the body text 
to wrap around it.
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Text Wrap is applied to 
the capital letter, causing 
the body text to wrap 
around it.

Ignore Text Wrap is applied to the frame 
containing the pull quote, which would 
otherwise be pushed out of its frame by 
the text wrap applied to the capital letter.

Inside InDesign: Text Wrap
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Prix d’une Pêche

Ingredients
Body or other text
1  Image (e.g., a pretty peach)
Text for topping
The Text Frame Options or Preferences dialog box

DIRECTIONS: Take one image, and apply 
text wrap to it by clicking the  icon  in 
the Text Wrap palette. Position the image 
over text. Next, create a text frame that will 
be positioned over the image. If you posi-
tion the text frame over the image, the text 
will be displaced by the Text Wrap applied 
to the image. Instead, open the Text Frame 
Options dialog box (Object > Text Frame 
Options) and check Ignore Text Wrap. You 
can now freely position the text over the 
image, without displacing the topping text! 
If you’re putting the entire store on sale, 
you can save time by simply turning on 
the Text Wrap Only Affects Text Beneath 
preference (InDesign > Preferences > Composition > Text Wrap). By this method, you don’t 
have to use the Ignore Text Wrap option in each instance. 

Use when you want the cool, refreshing pleasures of text sitting on top of an object to which 
Text Wrap has been applied.

DIANE BURNS is a pioneer in electronic publishing, founding TechArt International in 1984. One of the first 
Macintosh-based design firms in the country, TechArt today is one of the leaders in print and web design, 
specializing in East Asian languages. She is also the author of many books on publishing, and loves to cook.

Text Wrap is applied to the graphic, causing the body copy 
to wrap around it.

Ignore Text Wrap is applied to the frame containing the 
pricing text, which would otherwise be pushed out of its 
frame.



InTools 1.1
InTools is a set of powerful plug-ins 

for use with Adobe InDesign. This set

of tools will help expedite your most

common publishing tasks as well as

simplify your more daunting ones.

Whatever your InDesign needs are

geared towards — layout, design, or

production — InTools has something

for you.

InTools Includes:
InStarburst
InStarburst provides a quick method for creating
and customizing attention-getting starbursts,
which are completely editable.

InPathfinder
InPathfinder combines selected objects into 
single objects to create compound shapes, and it
lets you alter objects according to the shapes of
overlapping objects.

InItemMarks
InItemMarks provides convenient methods for
making custom crop marks and registration
marks for individual objects and pages.

InPrint
InPrint lets you select a portion of an InDesign
page and either print or save to a disk file
using one of many file formats.

InNudge
InNudge lets you interactively adjust the position
and rotation of objects and pictures with an
intuitive palette.

InModify
InModify provides a single dialog box for 
modifying all the attributes of a selected 
object or group, including options such as 
size, placement, stroke, angle, and fill.

Finally, a Tool Pack for 
Adobe® InDesign.®
Finally, a Tool Pack for 
Adobe® InDesign.®

InStarburst

InNudge

InPathfinder

InItemMarks

InModify

InPrint

Available for 
Macintosh and
Windows!

© Copyright 1990-2004. a lowly apprentice production, inc. All rights reserved.

For more information about InTools, or to download a free demo,
visit the a lowly apprentice production website at: www.alap.com

You can also call us toll free at: 1-888-818-5790
or 760-438-5790 (Canada/International) www.alap.com

http://www.alap.com
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Harry Potter  
and the Secret of InDesign

A quick look at InDesign’s scariest feature

by OLAV MARTIN KVERN

n the Harry Potter series of young adult novels, the villain,  
the dark wizard Voldemort, is so evil that the characters will not speak his 
name. Instead, they say “You Know Who” when they refer to him. 

This reminds me of one of my favorite features in InDesign, “You Know 
What.” Unlike Voldemort, this feature isn’t evil. It’s just misunderstood. 

“You Know What” is a great feature, and has the ability to make virtually 
everything about working with InDesign easier, faster, and better. In fact, your copy of 
InDesign comes with a set of useful features implemented using “You Know What” that 
you probably don’t even know you have. You don’t even have to know anything about “You 
Know What” to use these features—once you’ve installed them, they work just like any 
other feature in InDesign.

“You Know What,” of course, is InDesign scripting. If you learn one thing from this 
article, it should be: You do not need to know how to write scripts to be able to run scripts. 
This is a misunderstanding that prevents many people from even trying scripting, even 
though existing scripts might save them enormous amounts of time and trouble. You can 
find hundreds of InDesign scripts online—most are available for download for free—and 
it’s easy to install them. 

For that matter, chances are quite good that you can find someone who will write scripts 
for you, and would be willing to do so for the occasional expression of admiration or a 
small fee. 

Great Features You May Have Missed
Want to draw crop marks around the selected objects on a page? Or convert an oval to a 
rectangle? Run a bunch of find/change operations all at once? Select all of the image frames 
on a page or spread? Sort a list of paragraphs alphabetically? All of these things, and more, 
can be done using the example scripts that are on your InDesign CS disc. But first, you’ll 
have to find and install them.

To find the scripts, open the Adobe Technical Info folder on your InDesign CS CD—the 
example scripts are in the Scripting folder. If your copy of InDesign came as part of the 
Creative Suite, you’ll find the scripts on the Resources and Extras disc. 

InSide InDesign: Scripting
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If you’re using the Mac OS, you can use either the AppleScript (.as files) or JavaScript 
(.js) versions of the scripts; if you’re using Windows, you can use either the VBScript (.vbs) 
or JavaScript versions. (Because InDesign supports platform standard automation, you can 
also use other languages, such as Python or C#, but that’s beyond the scope of this article.)

Installing an InDesign script is easy: Put the script file (or an alias/shortcut to the file) in 
the Scripts folder (which lives inside the Presets folder within your InDesign folder). Cre-
ate the Scripts folder if it does not already exist.

Once the script is in the folder, it will appear in the Scripts palette inside InDesign—
choose Scripts from the Scripting submenu of the Window menu to display the palette 
(Figure 1). To run the script, double-click the script name in the Scripts palette. Most of the 
scripts have a user interface to make them look like any other software option, which of 
course is what they are (Figure 2). You can even assign a keyboard shortcut to a script using 
the Edit Shortcuts dialog box: Choose Scripts from the Product Area popup menu inside 
the Edit Keyboard Shortcuts dialog box and you’ll see all the scripts listed.

That’s pretty simple, right? If not, we’re not certain you should be using a 
computer at all (or driving a car, for that matter).

What the Example Scripts Do
Here’s a brief description of each of the example scripts on the InDesign CD:
< AddGuides draws guides around the selected object or objects.
< AddPoints adds additional editable points to the paths of the selected objects.
< CreateCharacterStyle: When you create a character style by example in 

InDesign, only the properties of the selected text that differ from the default 

ABOVE: Figure 1: Scripts palette with 
scripts installed

RIGHT: Figure 2: Most of the example 
scripts include a user interface

InSide InDesign: Scripting
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formatting of the text surrounding it are added to the character style. This 
script creates a complete character style based on the formatting of the selected 
text.

< CropMarks draws crop marks and/or registration marks around the selected 
object or objects (Figure 3). The AppleScript version of this script has a minor 
error—you need to set your measurement units to points before you run it, 
or you’ll be looking at very large printers marks. (Or, you can download the 
updated version Adobe has posted; see the URL at the end of this article).

< ExportAllStories exports all of the stories in a document to a specified folder as 
text, RTF, or InDesign tagged text.

< Neon creates a “glow” effect around the selected paths. Something like a blend 
in Illustrator.

< PathEffects changes the shape of the paths of the selected objects. Includes the 
ever-popular Illustrator effects “Bloat,” “Twirl,” and “Punk,” and the ability to 
convert objects to rectangles or ovals (as you can in QuarkXPress).

< RandomFill fills the selected frame or frames with random objects.
< SortParagraphs sorts the paragraphs in the selection alphabetically.
< TabUtilities sets a tab or an indent at the current cursor position, or sets a right 

tab exactly at the right edge of the text column.
< TextCleanup performs a series of find/change operations—you can define the 

changes using a simple text file.
< TextCounter counts the characters, words, or lines of text in the selection, in the 

text frame containing the selection, or in the story containing the selection. 
It’s about the same as the word count feature of the Info palette, but has a few 
additional capabilities.

What Else Can Scripts Do?
Scripts can do just about anything that you can do using InDesign’s 
user interface, and a few things that you can’t do. Don’t think 
about scripting only in terms of automating tedious, repetitive 
tasks. Scripting’s good for that, but you can also use it to speed 
up the smaller tasks that drive you crazy during the course of the 
day. When you take a common task that involves some number of 
actions and replace it with a simple double-click or keystroke (all 
it takes to run a script), you reduce the difficulty and complexity of 
your work.

Like what? Here’s an example: it can be a chore tracking down 
the original graphics files you’ve placed in your document. Sure, 
you can use the Links palette to show you the file path to a graphic, 
but it’s quite another thing to find that location on disk. Below is 
a simple JavaScript that opens the folder containing the selected 
graphic in the Finder (on the Mac OS) or in Windows Explorer. Figure 3: CropMarks dialog box.
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You can copy this out and save it as a text file in your Scripts folder (make sure the file’s 
name ends with .js), or download it from http://downloads.indesignmag.com/scripts/0704.zip.

//SimpleShowLink.js
//Opens the folder containing the selected graphic.
//Assumes that the graphic is selected using the Direct Selection tool.
var myFilePath = app.selection[0].itemLink.filePath;
myFilePath.parent.execute();

The above script will fail if you’ve selected the graphic with the Selection tool (rather 
than the Direct Selection tool). What if you want to select a graphic using the Selection 
tool, or select a series of graphics? To do that, we need to add a little bit more to the script. 
Something like this:

//ShowFolder.js
//An InDesign CS JavaScript
//
//This script opens the folder containing the selected linked file.
//
//Create a list--we’ll use it to store the qualifying graphics.
var myObjectList = new Array;
if(app.documents.length != 0){
 if(app.selection.length !=0){
  for(var myCounter = 0; myCounter < app.selection.length; myCounter ++){
   switch(app.selection[myCounter].constructor.name){
    case "Rectangle":
    case "Oval":
    case "Polygon":
    case "GraphicLine":
    case "Image":
    case "EPS":
    case "PDF":
     switch(app.selection[myCounter].constructor.name){
      //If a frame was selected with the Selection tool, and the frame 
      //contains a graphic, then add the graphic to the list.
      case "Rectangle":
      case "Oval":
      case "Polygon":
      case "GraphicLine":
       if(app.selection[myCounter].contentType == ContentType.graphicType){
        myObjectList.push(app.selection[myCounter].graphics.item(0));
       }
       break;
      //If a graphic was selected with the Direct Selection tool,
      //then add it to the list.
      default:
       myObjectList.push(app.selection[myCounter]);
       break;
     }
   }
  }
  if(myObjectList.length != 0){
   for(myCounter = 0; myCounter < myObjectList.length; myCounter++){
    myOpenLinkFolder(myObjectList[myCounter]);
   }
  }
 }
}
function myOpenLinkFolder(myGraphic){
 var myLink = myGraphic.itemLink;
 var myFilePath = myLink.filePath;
 myFilePath.parent.execute();
}

http://downloads.indesignmag.com/scripts/0704.zip
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Learning More about Scripting
In addition to the example scripts, the same folder on the CD contains the InDesign CS 
Scripting Guide. Don’t be daunted by the size of it (1800+ pages)—most of it is reference 
material (do you worry about the page count of a dictionary when you need to look up 
a single word?). If you want to learn more about writing your own scripts, the tutorial 
chapter of the Scripting Guide is the place to start. In it, you’ll learn how to create a docu-
ment, add a text frame, and enter and format text—and then move on to more complicated 
topics, such as displaying dialog boxes. Once you’ve worked your way through the tutorial, 
you’ll find more tutorials at: http://partners.adobe.com/asn/indesign/scripting.jsp 

You can also find lots of scripts on the Internet. For example, http://studio.adobe.com 
has lots of them that you can use for free, like one that adds a “Make Fraction” feature (in 
case you use a lot of fractions but aren’t currently using OpenType fonts). Another one 
runs Photoshop actions on selected images from within InDesign. Dave Saunders, an inde-
pendent InDesign scripter, has posted a number of script examples and scripting tips at his 
site http://www.pdsassoc.com, and the dynamic duo of Shane Stanley and Ray Robertson 
provide a number of InDesign scripting examples and case studies at their site http://www.
scriptingmatters.com. These folks also write custom scripts for a fee.

Now That You Know What…
Just as you probably don’t think about the millions of lines of C++ code that make up 
InDesign every time you choose a menu option or click a button in a palette, you don’t 
need to think about AppleScript, JavaScript, or VBScript when you run a script. But I’m 
hoping that once you see what InDesign scripting can do for you, you’ll want to learn how 
to write your own scripts.

After all, you can wait—possibly forever—for Adobe to add the features you want to 
InDesign, or you can add them yourself, today, using InDesign scripting. #

OLAV MARTIN KVERN never thought his weird urge to make computers make pictures would result in a paying job, 
much less a career spanning more than 20 years. He’s authored or co-authored a whole bunch of computer books, 
including Real World PageMaker, Real World FreeHand, and Real World Adobe InDesign, and many magazine 
articles and columns, including his column “Desktop Science” in Adobe Magazine. He’s been involved in the 
development of a number of software titles, including PageMaker, Visio, and InDesign. He’s designed and illustrated 
hundreds of books. All of this is still very surprising to him. He currently lives in Seattle and works for Adobe.

http://partners.adobe.com/asn/indesign/scripting.jsp
http://studio.adobe.com
http://www.pdsassoc.com
http://www.scriptingmatters.com
http://www.scriptingmatters.com
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Knowbody allows you to do more!

Knowbody ApS
Skjoldsgade 11

8260 Viby J.
Email: mail@knowbody.dk

Phone: +45 7023 7903

www.knowbody.dk

New InDesign Workflow Solution
Knowbody will present a new kind of workflow solution 
never seen before at MacWorld in Boston. It is based on 
XMP (XML data stored within the InDesign document). 
The workflow solution will allow you to register different 
stages for a document. You can then search your harddrive 
for any document with a specific stage: “In correction”, 
“Ready for PDF”, “Approved” etc.
Below is a sample of what the product also will do for you. 
Point the program to a folder and it will show you all the 
documents that uses pictures that need your attention - 
think of it as an external Link palette.

The scan is done within seconds since the solution only has 
to look for the XMP data. You will also be able to search 
your harddrive for documents that contain images that con-
tain part of a string. 
All this is done without having to open the documents and 
without any database installation. You will have an extreme-
ly inexpensive solution that is simple to use for everyone.

≠≠≠≠≠
on

VersionTracker

Customer specific development

Can’t you find what you need in order  
to have the most rational production?
Ask Knowbody for new features!

• Cool Kerning
• Cool Tracking
• Scale Alert 
• HPGL Import

• Stamp It
• Label It
• Color Markup

But Adobe® InDesign® has  
everything Knowbody needs in  
order to expand the product to fit 
your needs. 

With more than 14 years of experience 
in the graphic industry, Knowbody has 
developed a large amount of plugins to 
extend you possibilities.
Try these InDesign Plugins done by 
Knowbody and save money in your 
production:

No single design product lets you  

do everything you need! 

http://www.knowbody.dk


InDesigners: Scott Citron

cott Citron belongs to an elite group: designers who 
have used InDesign from the beginning. “InDesign 1.0 
crashed all the time,” he remembers. With a more-stable 
version 1.5, Citron retired his other page-layout applica-
tions to use InDesign exclusively in his design business. 
Now Citron is an in-demand InDesign instructor and 
trainer—he’s an Adobe Certified Expert—in addition to 

designing print publications, corporate identities, and advertising collateral. 
A former television producer whose credits include “Sex & The City,” 

Citron specializes in illustrated books, such as Four-Star Movies (Black Dog 
& Leventhal Publishers, 2004) and his current project Broadway Musicals: 
The 101 Greatest Shows of All Time to be published by Black Dog & Leventhal, 
a division of Workman. Citron recalls handing off the InDesign 1.5 files of 
Game Day by baseball star Derek Jeter (Three Rivers Press, 2001), to Crown 
Publishing and hearing the predictable reply: Can you send Quark files? “It 
wasn’t always easy to get InDesign accepted back then. Often I’d have to send 
EPS or PDF files instead.” Citron notes that many of his book projects are 
printed in Canada or Asia where InDesign files are readily accepted. “They 
were ahead of the curve compared to here,” he observes.

“Designing book interiors is hard work. It’s just page after page after page,” 
Citron says. “But InDesign makes it easier with features 
such as ‘make book,’ nested styles, and native Photoshop 
import.” 

Citron, who is also chair of the New York City InDe-
sign User Group—the world’s largest with more than 
1,000 members—says the demand for InDesign teachers 
and designers has “sky rocketed” in the last 18 months. 
“When I’m teaching InDesign, I see a lot of anxiety in 
QuarkXPress users who have been using that program 
for years, but within two to three hours they turn to me and say ‘this is really 
cool,’” he says. “I always felt that QuarkXPress with its rigid tools and rules 
put a wall between me and the computer. InDesign is much more fluid. It 
reflects the designer’s way of thinking and becomes part of the creative pro-
cess. It lets the design dictates itself.”

He pauses. “In fact, InDesign gives you so many options that you start 
spinning with possibilities.” —Pamela Pfiffner

Scott Citron Design
Tel 212.869-4900 
http://www.scottcitrondesign.com 
scott@scottcitrondesign.com
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LEFT: Three covers from the 
Common Reader Mystery book 
series. BELOW: Spreads and cover 
art from Broadway Musicals: The 
101 Greatest Shows of All Time. 
BOTTOM RIGHT: Cover art, The 
Hemmingway/Dos Passos Wars 
(Engadine Books, 2002)
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InReview: InDesign Plug-ins and InDesign Tools

Figure 1: Cool Kerning’s 
“master” document contains all 
custom kern pairs.
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TYPE TOOLS

Cool Kerning and Cool Tracking
Knowbody ApS, Denmark
http://www.knowbody.dk
Price: Each plug-in costs $150/year or €119,00/year for a single-user license; multi-user 
pricing available. Download demo versions of each product from http://www.knowbody.dk

By JOHN CRUISE
When it comes to typographic features, InDesign has distanced itself from the competition 
(read QuarkXPress) by offering such goodies as optical kerning, optical margin alignment, 
nested styles, and full support for OpenType fonts. However, it does lack a pair of useful 
typographic features that are available in QuarkXPress—the ability to create custom kern-
ing tables and custom tracking tables.

If you’re the kind of detail-oriented typographer who likes to get your fingers dirty by 
creating your own kerning and tracking tables, I have some good news and some bad news 
for you. The good news is that a pair of plug-ins for InDesign CS called Cool Kerning and 
Cool Tracking let you do this, and in some ways they exceed the QuarkXPress kerning and 
tracking editors. The bad news is they have some flaws that compromise their value.

Cool Kerning
If you’ve come to InDesign via QuarkXPress and are familiar with the latter’s 
kerning editor, the first thing you’ll notice about Cool Kerning is that the 
interface is quite different, as is the process of creating kern pairs. With Cool 
Kerning, the first thing you do is create a “master” InDesign document and 
enter all the kern pairs you want to modify (you don’t specify custom kerning 
values until later). You then save the document to a central location—on your 
hard disk if you’re working alone or on a server if it will be used by others—
and specify the file as the master.

The next step is to create one or more kerning “packages.” If you’re accus-
tomed to the QuarkXPress kern editor, the concept of packages can be a little 
tough. Each Cool Kerning package is a complete set of custom kern pairs for 
one or more font styles (bold, italic, etc.). For example, a design agency with 
several clients could create a separate package for each client. Each pack-
age can contain custom kern pairs for a different set of fonts. This is a major 
improvement over the QuarkXPress kerning editor, which lets you create 

only one kerning table (and one tracking table) per font style. Kerning packages are pass-
word-protected to prevent unauthorized modifications.

Each time you create a new package you assign a name (e.g., “Client A”) and a password. 
Next, you add font tables to the package. All kerning values for a specific font/family are 
stored in a font table. Each time you create a new font table, the master document opens. 
You then select all the text and choose a font family and style. The next task is to enter cus-

http://www.knowbody.dk
http://www.knowbody.dk
http://www.knowbody.dk
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tom kern values for the character pairs using the Kerning 
field in the Control palette or the Character palette. Dur-
ing this process, you can print proofs of the master docu-
ment—preferably to the printer you’ll be using for final 
output—to check the appearance of the kerning values 
you’ve specified. (The ability to print proofs of custom kern 
pairs is another improvement over QuarkXPress.) 

When you’re happy with the results, you save the font 
table to the package. After you’ve added all the font fami-

lies/styles you want to include in a package, you can export it so it can be used by others. 
You’re now ready to begin using your custom kerning values—almost (Figure 2). (Note: 
Cool Kerning saves its custom kerning values in the InDesign Defaults file, as well as in 
documents that use Cool Kerning.)

You enable Cool Kerning for a document by clicking the Activated button in the Cool 
Kerning palette. You would think that once you enable Cool Kerning, it would kick in and 
start applying your custom kerning values as you enter text—but you’d be wrong. You must 
either save the document or click the Document button in the Cool Kerning palette to 
apply custom kerning values. If you enable the Interactive checkbox, the Update Next but-
ton replaces the Document button, and you can apply custom kerning values one at a time 
by clicking the button—a cumbersome option if a document has more than a few custom 
kerning pairs. Although Cool Kerning is smart enough not to override custom kerning 
applied manually, its inability to apply custom kerning automatically is a serious limitation. 

Because Cool Kerning is a little tricky to use, a well-written manual would be useful. 
Unfortunately, the PDF manual covers the previous version of the software and is skimpy, 
poorly translated, and has numerous spelling errors. The Knowbody Web site includes a set 
of helpful instructional movies, but they don’t make up for the lack of good written docu-
mentation.

If Cool Kerning were an inexpensive product, some of the aforementioned problems might 
be forgivable, however, its $150 single-user price is a little steep. To make matters worse, the 
license is only good for one year, after which you have to shell out another 150 bucks. 

Cool Tracking
Cool Tracking is a lot like Cool Kerning. The user interfaces are nearly identical, and while 
you don’t create a master tracking document as you do with Cool Kerning, you can create 
multiple tracking packages and use them for different clients or different publications. Each 
time you add a font family/style to a package, the Edit Tracking dialog box and a tempo-
rary document are displayed. The controls in the dialog box let you choose a font family 
and a font style, and then adjust its tracking curve.

When you’re done adding and editing tracking curves, you apply the modified tracking 
values the same way you apply Cool Kerning-adjusted kerning values. If you’ve specified 
a tracking value as part of any paragraph styles or character styles, Cool Tracking will not 

Figure 2: All Cool Kerning-
related controls and commands 
are found in the Cool Kerning 
palette.
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override any text formatted with those styles. However, if you want to override the tracking 
value in text that’s been formatted with a paragraph or character style, you can highlight 
the text and click the Clear Selection button. The next time you save the document, Cool 
Tracking will apply custom tracking values (Figure 3).

Although Cool Tracking is a little easier to use than Cool Kerning, it suffers from nearly 
all the same problems with poor documentation and high license fees. And because 
custom tracking values aren’t applied until you save a document, you don’t get true WYSI-
WYG display of custom-tracked fonts as you work on text. 

To their credit, Cool Kerning and Cool Tracking provide several useful features, particu-
larly the ability to print proofs and save multiple kerning and tracking packages. If you’ve 
relied on QuarkXPress’ kerning and tracking editors in the past and can’t function with-
out comparable tools in InDesign, Cool Kerning and Cool Tracking fit the bill. However, 
given their limitations and pricing structure, you might want to consider the alternative of 
buying a dedicated font-editing program, such as FontLab, which lets you customize your 
fonts however you want and use them in all of your applications.

GRAPHIC TOOLS

InEffects 1.0
A Lowly Apprentice Productions
http://www.alap.com/
Price: $99.99 Download 15-day demo version from http://www.alap.com/indesign.html.

If you adhere to the motto that too much is never enough, then you’ll want to check out 
InEffects, a nifty plug-in from A Lowly Apprentice Productions (alap) that adds several 
Photoshop transparency effects to InDesign’s built-in effects (i.e., drop shadows, feathered 
edges, opacity, and blending modes). 

Figure 3: When you create or 
edit tracking for a font family/
style, Cool Tracking opens 
a temporary document that 
displays tracked sample text at 
several font sizes. As with Cool 
Kerning, you can print proof as 
you modify a tracking curve.

http://www.alap.com/
 http://www.alap.com/indesign.html
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DROP
SHADOW

InEffects includes five special effects that you can apply to any placed graphics and 
native InDesign object. It also one-ups InDesign’s transparency capabilities by letting you 
save and apply InEffects styles, much the same as you can save and apply character and 
paragraph styles (more about this later). Each of the effects includes a set of controls for 
modifying the appearance of the effect, and most effects have similar controls. As you can 
with InDesign’s drop-shadow feature, you can specify the blending mode, opacity value, 
color, and blur amount for any effect, as well as noise and intensity in most cases. You can 
also apply multiple effects to a single object (Figure 1). 

Here’s a description of each of the transparency effects that InEffects adds to InDesign:

DROP SHADOW Although InDesign has its own drop-shadow feature, the ability to cre-
ate drop shadows with InEffects offers a few additional benefits. One is that InEffects lets 
you add noise, which randomly redistributes pixels to give drop shadows a slightly more 
natural appearance than those you get with InDesign’s drop-shadow feature. InEffects also 
provides intensity controls for strengthening or softening a shadow(Figure 2). (Note: With 
the exception of the Bevel and Emboss effect, all other effects include noise and intensity 
controls.) Another benefit is that you can use InDesign’s drop-shadow feature (Object 
> Drop Shadow) to add a second drop shadow to any object that has an InEffects drop 
shadow (or vice versa). The ability to apply a double-drop shadow to a single object opens 
up some interesting design possibilities (Figure 3).

It’s worth noting that the InEffects dialog box, which you use to create effects for indi-
vidual objects as well as InEffects styles, looks and feels more like Photoshop than InDe-
sign. For example, with InDesign you position a drop shadow by specifying X and Y offsets, 
while with InEffects you specify a distance and an angle. The differences aren’t confusing, 
but it would have made more sense to model InEffects on the InDesign interface than the 
Photoshop interface. 

INNER SHADOW An inner shadow is similar to a drop shadow except that the shadow is 
applied along the inside rather than outside edge of an object, creating a hollow, 3D-like 
appearance (Figure 4).

OUTER GLOW An outer glow is essentially a drop shadow without an offset. The Outer Glow 
pane is similar to the Drop Shadow pane but lacks the Distance and Angle controls (Figure 5).

INNER GLOW An inner glow is similar to an outer glow, which is why the inner glow and 
outer glow panes are almost identical (Figure 6).

BEVEL AND EMBOSS When you apply this effect to an object, shadows and highlights are 
added to produce a raised, 3D appearance (Figure 7).

The InEffects Styles palette (Window > InEffects) lets you save InEffects styles and apply 
them to any object—a significant improvement over InDesign, which lets you change the 
default settings for drop shadows and feathered edges but doesn’t let you save styles. Cre-
ating an InEffects style is similar to creating a character or paragraph style. If no object is 
selected, you can start from scratch by choosing New InEffects Style from the InEffects 
Styles palette menu. If an object is selected when you choose New InEffects Style, any 

Figure 1: The original image at 
top is a Photoshop JPEG file 
that includes an embedded 
clipping path. An inner bevel is 
applied to the example in the 
center. The variation at bottom 
includes both an inner bevel 
and an outer glow. 

DROP
SHADOW

Figure 2: InEffects’ Drop 
Shadow controls let you vary 
such attributes as blends 
modes, noise and intensity..

Figure 3: The gray drop shadow 
was created with InEffects; the 
pink drop shadow was created 
with InDesign’s Drop Shadow 
feature.
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applied InEffects settings are retained in the InEffects dialog box. If you modify an InEf-
fects style, any objects to which it’s applied are automatically updated (Figure 8).

If you intend to share InDesign files that use InEffects with colleagues, clients, or output 
providers, you can provide them with the free InEffects Viewer plug-in, which allows them 

to open, display, and print documents that use InEffects without having the full product. 
(The Viewer does not allow you to modify InEffects settings, however.)

The value of InEffects depends on how much you’ll use it. If you currently use Photo-
shop to create graphics with similar effects that you place in InDesign layouts, changing 
to InEffects will save you the time and hassle of switching between programs. The file 
management overhead involved with placed graphics will be lessened as well. And if you 
change your mind and need to modify an effect created with InEffects, it’s a lot easier to 
change InEffects settings within InDesign than it is to open and modify a separate graphic 
file in a separate program. 

The option to save and apply InEffects styles is another valuable productivity enhancer. If 
you currently use InDesign to create a significant number of drop shadows with a variety of 
settings, then you spend considerable time fiddling with the controls in the Drop Shadow 
dialog box. By automating the task of creating drop shadows—and any of the other effects 
this plug-in offers—using InEffects styles you can save gobs of manual formatting time.

The only drawback with InEffects is that there’s not enough of it.  Given that InDesign 
already lets you create drop shadows and outer glows (which are essentially drop shadows 
with no offsets), InEffects adds only three additional transparency effects to InDesign. 
That’s not a whole lot for a hundred bucks. If alap wants to make InEffects even more 
appealing, it would be smart to include a few more Photoshop effects—like, for example, 
Gradient Overlay (something the off-the-shelf version of InDesign can’t do). Now that 
would be too cool. #

JOHN CRUISE is a Denver-based writer and trainer who has co-authored books about InDesign and QuarkXPress.
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Figure 4: Inner Shadow
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Figure 7: Bevel and Emboss

Figure 8: InEffects Styles Palette



 JULY | AUGUST  2004 * InDesign Magazine 35

Training Materials 

Learning Adobe InDesign CS with David Reeser
Lynda.com
http://www.lynda.com
Price: $99.95 Download sample movies from http://movielibrary.lynda.com/html/modPage.
asp?ID=89 

By KACEY CROUCH
As an Adobe Certified Trainer for InDesign, I’m always leery of training CD-ROMs. Of 
course, I have a vested interest in keeping my schedule crammed with training appoint-
ments, but mostly I wonder if the experience of a self-paced curriculum is as effective as 
classroom instruction. “Learning Adobe inDesign CS” is one of several CDs currently 
available for teaching the novice user how to use InDesign. 

Designed for both the Macintosh and Windows platforms, this single-disc package con-
tains a series of QuickTime movies that describe the software along with lesson files that 
you use to work with in InDesign CS.

Interface Issues
While the interface has a very creative, attractive design, initially I did not find it to be 
especially user friendly. The CD automatically plays in full-screen mode, which inhibits 
the viewer from following along in InDesign while the movie is playing. To get around 
this, you must either change your preferences (which is a little scary because it states that a 
restart is necessary), or in the initial CD window, you can play the file called WindowMode, 
which makes it possible to toggle back and forth from the presentation to InDesign.

After becoming accustomed to the methodology, I found the CD quite simple to work 
with. As long as you keep the movie window open, it tracks which chapters have been viewed, 
and it allows you to jump around from one chapter to the next fairly easily (Figure 1).  

Figure 1: The movie controls at 
right let you navigate easily through 
the lessons, such as this one about 
graphics and drop shadows. The 
InDesign practice file for this lesson 
is shown in the background.

http://www.lynda.com
http://movielibrary.lynda.com/html/modPage.asp?ID=89
http://movielibrary.lynda.com/html/modPage.asp?ID=89
http://movielibrary.lynda.com/html/modPage.asp?ID=89
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A glossary of terminology would have been helpful. As the tutorial was geared for begin-
ners, there are times when technical terms are used without definitions.

I was very pleased to find all of the files that the commentator was working with on the 
CD, but the narrator didn’t state the name of each file as he worked with them. This would 
have allowed me, in some instances, to follow along with the audio portion of the movie 
running in the background. After trying to jump back and forth between the presentation 
and InDesign, I decided it was much easier to watch a portion of the movie, absorb it, and 
then go into InDesign to try out what I learned. 

For a “beginner level” tutorial, I found the content selection to be appropriate, and 
well thought out. The order in which it is presented is also suitable. The images selected 
throughout the projects were interesting, although working with some real, “non-greeked” 
text would make the projects a bit more exciting.

The movie begins with a fine overview of the work area, moves on to setting up pages, 
and working with text and graphics. Some more advanced topics such as tables, books and 
interactive PDFs are even touched on.

There are a few areas that could have been made a little clearer. For example, the sections 
relating to the different selection tools, and the difference between frames and paths are a 
bit convoluted. The section describing the Pen Tool should either be simplified, or moved 
to a later point in the movie.

David Reeser has a very pleasant tone. I did not tire of listening to him during the five-
hour movie. He is quite articulate, and uses good inflection. I wouldn’t object to the use of 
a little humor interspersed, but Mr. Reeser makes a very professional presentation. To view 
a clip of Mr. Reeser discussing the Swatches palette, click here: http://movielibrary.lynda.
com/html/modDemoPlayer.asp?ModID=89&ModMovieID=5169&chap_num=2&s=

There are a few areas of the movie that need some editing. For example, small slips of 
the tongue occur. The section on the selection tools was confusing because Reeser mixed 
up the names of the Selection Tool and the Direct Selection Tool on multiple occasions—
again, a little editing would fix that.

All in all, “Learning Adobe InDesign CS” is a solid lesson course for a beginner. The 
viewer should enjoy sitting back and observing—rather than doing. I would recommend 
this CD-ROM for an individual looking for a foundation before moving on to more in-
depth training.

KACEY CROUCH, Adobe Certified Instructor, operates PixelDot, Inc., a graphics-training company based in  
South Florida. 

http://movielibrary.lynda.com/html/modDemoPlayer.asp?ModID=89&ModMovieID=5169&chap_num=2&s=
http://movielibrary.lynda.com/html/modDemoPlayer.asp?ModID=89&ModMovieID=5169&chap_num=2&s=
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Get Your Free InDesign Shortcut Guide  

Real World Adobe InDesign CS
0-321-21921-X

InDesign CS Killer Tips
0-7357-1402-9

Adobe InDesign CS Classroom in a Book
0-321-19377-6

InDesign CS for Macintosh and
Windows: Visual QuickStart Guide
0-321-21348-3

Essential books for the creative community

Peachpit

Head to peachpit.com/indesign
and download a free shortcut
cheatsheat that lists all the key
commands you need to speed
your workflow and design like
a pro. Plus, find out how you
can save 30% on all our
InDesign guides!

Hot InDesign Titles from Peachpit Press!

http://www.peachpit.com/indesign
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In the News

Meredith Publishing, 
Hearst Magazines take  
the InDesign plunge
Confirming what has long been 
rumored in InDesign circles, Hearst 
Magazines and Meredith Publish-
ing both announced that they are 
switching to InDesign CS 
and an all Adobe Creative 
Suite workflow. 

Hearst titles include 
such newsstand mainstays 
as Esquire, Good House-
keeping, Harper’s Bazaar, 
Oprah Magazine, Redbook, 
and Seventeen. Meredith, 
based in Des Moines, 
Iowa, publishes Better 
Homes and Gardens, 
Ladies’ Home Journal, 
and MORE, among 
others. 

Saving Money at Hearst
Currently, the only Hearst publica-
tions to use InDesign are Cosmo-
politan, Popular Mechanics, Marie 
Claire, and House Beautiful. A new 
magazine premiering in August—
Shop Etc.—will be produced from 
its inception with InDesign. Popu-
lar Mechanics recently underwent 
an InDesign overhaul by noted 
publication designer Roger Black, 
while Marie Claire has been using 
InDesign for “the last eight or nine 
months,” according to Creative 
Director Paul Martinez.

The rest of Hearst’s titles—18 total 
in the U.S. and 137 international 
editions—will convert by 2005.

According to a July 6 press release, 
Hearst cited the cost benefits of 
working with an integrated product 
suite as a main reason for converting. 

“In addition to implementing a color-
managed workflow and bringing pre-
press in-house, Hearst Magazines is 

leveraging the capabilities of Adobe 
PDF and InDesign CS to become 
more competitive,” said Ellen Payne, 
director of editorial operations for 
Hearst Magazines. She noted that 
InDesign CS lets more magazines do 
prepress in-house, “saving signifi-
cant amounts of time and money in 
design and production.”

Making a Transition at Meredith
At Meredith, the decision to adopt 
InDesign CS emerged after “exten-
sive research” by a committee of 
designers, editors, and IT person-
nel, according to Bob Furstenau, IT 
Director of Publishing Services. 

“After several months of testing, 
the committee determined that 
InDesign is a superior layout pro-
gram to QuarkXPress,” noted Fur-

stenau. “The new software will offer 
many benefits and function most 
effectively with Mac OS X, Apple’s 
newest operating system which will 
be installed as an upgrade later this 
year.”

The Meredith Publishing Group 
includes 17 magazine brands, more 
than 160 special interest publica-
tions, and nearly 300 books in print. 

Furstenau acknowledged that the 
simultaneous transition to a new 
operating system and new page-lay-
out application present “some chal-
lenges.” Migration plans are under-
way, with an eye toward launching 
a pilot program in October. The rest 
of Meredith’s magazines and book 
titles will follow suit in early 2005.

Reports show InDesign CS 
gives productivity edge
An extensive study conducted by 
independent research firm Pfeiffer 
Consulting reports that Adobe 
InDesign CS offers significant gains 
in productivity over QuarkXPress 
6.1 in most publishing and design 
tasks. 

The Adobe InDesign CS Bench-
mark Project, commissioned by 
Adobe Systems, was based on a 
series of benchmark tests Pfeiffer 
conducted in real-world environ-
ments, such as creative design and 
magazine publishing. Among the 
tasks were producing page spreads, 
applying drop shadows, styling text, 
and generating PDFs. 

Productivity vs. Performance
InDesign CS showed a clear advan-

In her latest 
fi lm. De-Lovely,  

Ashley Judd plays 
the smart and 

outspoken wife of 
songwriter Cole 
Porter. As marie 

Claire’s guest 
Editor-in Chief 

she’s equally 
feisty. Here she 

tells us what she 
learned from 

her family about 
speaking up and 

why she thinks 
the day you vote 

is more important 
than the day you 

were born

This spread in Hearst’s Marie Claire magazine was designed by 
Creative Director Paul Martinez in InDesign 2.0
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tage in areas of design creativity, 
thanks to its integration with Illus-
trator and Photoshop. Tasks that 
in QuarkXPress require exiting the 
page-layout environment—such as 
editing images in Photoshop—were 
accomplished more than three times 
faster in InDesign CS. 
InDesign’s built-in 
support for common 
effects excelled as well. 

“During the productiv-
ity benchmarks, the 
creation of frequently used design 
effects such as transparency or drop 
shadows took up to seven times 
longer with QuarkXPress and Pho-
toshop than with InDesign CS,” the 
report says.

Overall, the Pfeiffer report found 
InDesign CS to offer a two-to-one 
edge in design productivity over 
QuarkXPress 6.x. Pfeiffer did find 
QuarkXPress to be faster in some 
areas such as text and image import, 
but InDesign CS excelled at generat-
ing screen displays and exporting 
PDF files. 

But as the report notes, produc-
tivity, while critical, isn’t every-
thing. “What’s interesting in terms 
of design is that an effect, say a 
drop shadow, which is the result or 
endpoint of the creative process in a 
classic workflow, becomes the start-
ing point for new design experimen-
tation when working with InDesign,” 
Andreas Pfeiffer, author of the study, 
told InDesign Magazine.

The Cost of Creativity
A second Pfeiffer Consulting study 

analyzing the cost of switching to 
InDesign indicates that 50 percent 
of publishing sites using InDesign 
found the transition to be less dif-
ficult than expected. “This is an 
important point,” notes the report 
entitled Adobe InDesign CS: ROI and 

Migration Strategies, “for 
most technology manag-
ers in larger corporations, 
one of the major barriers 
to adoption of InDesign is 
the anticipated complexity 

of migration.”
The ROI analysis dovetails with 

the productivity report, for example, 
pointing out that fewer steps in a 
production workflow reduces the 
potential for error, which ultimately 
saves time and therefore money. 

The calculations for creative work 
are even more interesting. Pfeiffer 
proposes that for a designer who 
charges $100 per hour, each minute 
is worth $1.60. Based on the produc-
tivity report findings, a drop shadow 
created in InDesign CS yields an ROI 

of $2.99 when compared to using the 
QuarkXPress 6-Photoshop combo.

Ultimately, the report found, 
saving money isn’t InDesign’s only 
return on investment: “For many 
design professionals, saving billable 
hours is not nearly as important as 
gaining or maintaining the creative 
edge in a highly competitive mar-
ketplace. While most respondents 
in this research project agree that 
their current workflows more or less 
answer their needs for print produc-
tion, they may assess the situation 
differently once they lose a client 
project to a competitor who’s using 
InDesign.”

To download a copy of the 
reports, including the detailed 
results and the methodology used, 
go to http://www.pfeifferreport.com/
dtalabs.html.

Releasing a new product? Know about a 
company that’s making the switch? Send news 
tips to editor@indesignmag.com.

InEffective? InCoherent?

CLEANING OUT a cluttered kitchen drawer the other day, I stumbled across an early 
piece of InDesign marketing: a magnet set commemorating the release of InDesign 1.0. 
As with promotional posters before them, the magnets played on words that, like the 

product itself, begin with “in,” such as “inspire.” I had 
never opened the package, but assumed that like most 
fridge art all pieces were magnetized, allowing me to 
couple the big red I-N letters with any of the truncated 
words. Much to my surprise, the individual letters are 
not magnets at all, but paper cutouts surrounded by 
glitter and sealed in plastic. 

In other words, my ticket stubs, yoga schedules, 
and shopping lists would be stuck to the door with 
SPIRE, TEGRATE, NOVATE, TUITIVE and GENIOUS. 

No “IN” in sight.—PAMELA PFIFFNER

http://www.pfeifferreport.com/dtalabs.html
http://www.pfeifferreport.com/dtalabs.html
mailto:editor@indesignmag.com
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Conferences & Events 
ADOBE CREATIVE SUITE TOUR AND ONLINE SEMINARS 
Various Locations
See description for times
Live tour combines information for creative professionals and 
print service providers. Covers Photoshop CS, InDesign CS, 
Illustrator CS, GoLive CS, Acrobat 6.0 Professional and Version 
Cue. Cities and dates: Orlando, July 21-22; San Antonio, July 
28-29; Greenbelt, MD, August 3-4; Madison, August 10-11; 
Durham, August 11-12; Sacramento, August 11-12. 
INFO: http://adobe.regsvc.com/cssptour
Online seminars are geared for print service providers who need 
to produce documents with latest software versions. 
AUGUST 5: 9-10:30 a.m. InDesign CS; 12-1:30 p.m. Acrobat 6.0 
Professional. AUGUST 17: 9-10:30 a.m. Illustrator CS; 12-1:30 p.m. 
Creative Suite. AUGUST 19: 9-10:30 a.m. Acrobat 6.0 Professional; 
12-1:30 p.m. InDesign CS. AUGUST 24: 9-10:30 a.m. Creative 
Suite; 12-1:30 p.m. Illustrator CS
INFO: http://www.adobe.com/spseminars

SEYBOLD SEMINARS SAN FRANCISCO 2004
Moscone West, San Francisco
August 6-9
Includes conference session entitled “Face-Off: Adobe InDesign 
and QuarkXPress” as part of Cross-Media Design Day. Tutorials 
include: “InDesign for Quark-experienced Users”; “Advanced 
QuarkXPress and InDesign Techniques”; “Tips and Tricks for 
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Adobe Products”—all taught by David Blatner—and “Printing 
and PDF: Using the Creative Suite” with Steve Werner.
INFO: http://www.seybold365.com/sf2004/

PHOTOSHOPWORLD
Orange County Convention Center, Orlando
September -3
Includes “Adobe InDesign CS Tips and Tricks” with Adobe’s 
Terry White, “Unlocking the Power of Adobe’s Creative Suite” 
with Taz Tally, plus Photoshop sessions galore taught by the 
likes of Scott Kelby, Bert Monroy, Katrin Eismann, Deke Mc-
Clelland, Dan Margulis, Ben Willmore, and Adobe’s Julieanne 
Kost. Intriguing session titles: “The Art of Photographing 
Women LIVE!” and “The Art of Retouching Women LIVE!” 
INFO: http://www.photoshopworld.com/

THE INDESIGN CONFERENCE AUSTRALIA
Crown Promenade Hotel, Melbourne
October 4-6 (Rescheduled from August )
Includes sessions on every aspect of InDesign, from text to tables, 
from PageMaker to PDF. Speakers include David Blatner, Sandee 
Cohen, Tim Cole, and Deke McClelland from the U.S. and Matt 
Davis, Eliot Harper, and Mike McHugh from Down Under. 
INFO: http://www.theindesignconference.com/australia/indexa.html  
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TRAINING

CUSTOMIZED CORPORATE INDESIGN 
TRAINING: Sandee Cohen, author of 
the InDesign Visual QuickStart Guide, 
is available for corporate training in 
InDesign, InCopy, Acrobat. Previous 
clients include book and magazine 
publishers, design firms, advertising 
agencies, newspapers, and financial 
companies. Let me help you design 
a customized training environ-
ment which includes on-site hands-
on classes, lecture/demonstration 
seminars, one-on-one instructions, or 
group refresher courses. Special atten-
tion given for ex-Quark users looking 
to make the transition to InDesign. 
Training also includes at-cost pur-
chases for books and video support 
material. Contact sandee@vectorbabe.
com for available dates and rates.

INDESIGN CS EXPERT TRAINING: 
Adobe Certified Expert and designer 
with top credentials available for 
training anytime/anywhere. For 
more info please go to http://scottcit-
rondesign.com or e-mail me at 
scott@scottcitrondesign.com.

NY AREA ADOBE TRAINER: Available 
for Illustrator, InDesign, and Photo-
shop. Adobe Certified Expert. Contact 
Mordy at www.designresponsibly.com 
or mordy@mordy.com.

INDESIGN TRAINING VIDEOS: By Sand-
ee Cohen and David Blatner avail-
able on CD from Software Cinema, 
including titles such as “InDesign for 
QuarkXPress Users” and “Page Layout 

Tips and Tricks.” See www.software-
cinema.com for more information or 
call 858-538-9957. Use promotion code 
DB04 for 5% off any title, including 
Photoshop training!

SOFTWARE

FREE PLUG-IN: Gives you an InDesign 
tip-of-the-day from author David 
Blatner. Available for Mac and Win-
dows from alap. Go to www.alap.
com/products/intips.html.

COOL PATTERNS: InDesign plug-in 
gives you fully customizable patterns 
and textures inside any InDesign 
frame. See http://www.teacupsoft-
ware.com for more information.

FREE TEMPLATES: Download free 
templates for InDesign documents at 
http://desktoppub.about.com/od/tem-
platesindesign/.

BUY PLUG-INS HERE: Find the plug-
ins you need in one central location. 
Go to www.thepowerxchange.com.

SOLUTIONS

INDESIGN AUTOMATION & TRAINING: 
SF Bay Area consultants with exten-
sive experience in Adobe InDesign 2 
and CS training, scripting, and work-
flow automation: from one student to 
many; from simple standalone scripts 
to complex systems with sophisticated 
user interfaces. InDesign Adobe Cer-
tified Expert. Premedia Systems, Inc. 
http://www.premediasystems.com.

SERVICES

FOREIGN LANGUAGE DESIGN AND 
PRODUCTION SERVICES: Since 984, 
San Francisco-based TechArt Inter-
national is a leading provider of print 
and web localization services with 
a specialty in East Asian languages, 
including Japanese, Chinese, and 
Korean. TechArt provides support to 
American companies in these markets 
with project management, design and 
production services, and prepress 
consulting. 45-362-0. http://www.
techart.com

RATES  
& INFO 
InDesign Magazine publishes classified ads 
in the following categories: Training (for  
InDesign and Adobe instructors); Services 
(for print providers who accept InDesign 
files); Solutions (for workflow consultants 
and systems integrators); Software (for 
InDesign resources); and Seekers (for those 
looking for design or production work in 
the InDesign field). Cost: $25 for up to 
25 words; $50 for up to 50 words . Next 
due date: September 1, 2004. Send copy to 
production@indesignmag.com.

Classifieds: For InDesign Users
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Art Parts NOW!
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Agency-Quality Graphic
Design Templates

1-877-833-3305
View our design library online at 
www.stocklayouts.com

Create great looking marketing
materials affordably and quickly.
Available for QuarkXPress™, Adobe® InDesign®,
Adobe PageMaker®, Adobe Illustrator® 
or Microsoft® Publisher.

• Fully customizable pre-designed layout file

• High resolution stock photos and artwork

• Suitable for high-quality commercial printing
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